
CHAPTER 2

A FIRST LOOK AT C++ SOURCE PROGRAMS

We have already seen one C++ source program in the previous chapter in Figure 1-3, but 
we have not yet tried to understand it. In this chapter, we shall study a couple of computer 
programs, including the one in Figure 1-3. You will learn some basic things, such as

• how a C++ program displays text on the screen,
• how a C++ program reads in numbers from the keyboard,
• how simple calculations can be made in C++ programs, and
• how C++ programs can be compiled and executed.

After this chapter, you will know something about C++ programming, but it is likely that 
you will have many questions in your mind. You may think

• how can a variable store information?
• what is actually happening during compilation?
• how does a computer execute programs?

It is perfectly natural to have these questions in your mind. In chapters 3 and 4 we shall 
study some basics of computing, and these questions will be answered then.
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2.1  A program that can print text to the screen

The simplest things computer programs can do is to read in some data (e.g. numbers or
text) from the keyboard, do something to that data, and then print something to the screen.
Perhaps the simplest computer program is one that just prints a single sentence of text to
the screen. Such a computer program is first.cpp which is presented in a program descrip-
tion on the page opposite. Later on in this chapter, you will be instructed how to get the
file first.cpp on your own computer. When the program is compiled and executed on a
computer, the following line will appear on the screen of the computer:

I am a simple computer program.

By studying program first.cpp you can discover that, in some ways, computer pro-
grams resemble texts written in natural languages like English. For example, the program
first.cpp contains such natural words as include and main. On the other hand, program
texts are in many ways much more complex than natural-language texts. For example,
there are special characters like #  <  >  {  }  (  )   ;  and a special name cout in use in pro-
gram first.cpp. All these characters have a special meaning in the program. The special
characters are interpreted by the compiler of the C++ programming language when the
program is transformed into an executable form.

The act of printing text to the screen of a computer is called output. We say that a
program can output text to the screen. In program first.cpp text output is performed by the
output statement

cout  <<  "I am a simple computer program." ;

The output mechanism of the C++ programming language is such that the name cout rep-
resents the screen and << is an operator that is used to move, or shift, text to the screen.
The text to be printed must be written inside double quote characters. << is an output oper-
ator, and cout is an output stream representing the screen of the computer. We can imag-
ine that with operator << we add text to the output stream.

cout, which is usually pronounced "see-out", is defined in the file named ios-
tream.h. This file is included in program first.cpp with the command

#include <iostream.h>

We will have this include command at the beginning of every example program in this
book. The file iostream.h comes with the C++ compiler, and it contains important defini-
tions related to input and output. It is important that you remember to write the above
command at the beginning of your programs, but you do not have to examine what is
inside the file iostream.h.

All C++ programs must be written according to a certain structure, that is, the syntax
of the programming language. All C++ programs up until Chapter 8 of this book follow
the structure

#include <iostream.h>

int main()
{
   ...
}

The meaning of the three dots is "some program lines written with C++". In the place of
the three dots there is something different in each program, but in our first programs there
is always int main() followed by an opening brace { which indicates where the actual
program statements begin, and then there is a closing brace } which terminates the pro-
gram.
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#include <iostream.h>

int main()
{
   cout  <<  "I am a simple computer program." ;
}

In this book, example computer programs are described so 
that the actual program text is explained within "balloons" such 
as these. These balloons are not part of the computer program. 
Instead, they are a means to teach you. The arrow originating 
from this balloon points to the first line of program first.cpp. 
This program has only six lines of which one is an empty line. 
Note that the actual program is always written with the font 
called courier.

This is the line in this source 
program which specifies what 
will be printed to the screen when 
the program is executed. The text 
to be printed to the screen must 
be written "inside double quote 
characters", and there must be a 
semicolon ; at the end.

first.cpp - 1.  A C++ program that prints a single line of text to the screen.

Pairs of braces { } are used to 
group the program statements in 
C++. This closing brace termi-
nates the entire program. In this 
case there is only one statement 
inside the braces

This text is not part of the computer program. 
Instead, it contributes to how computer programs 
are described in this book. Note that these caption 
texts always show what the physical file name of 
the program is. This program can be found by 
name first.cpp.

first.cpp - X.  The execution of the compiled program first.exe

D:\book1cpp>first
I am a simple computer program.
D:\book1cpp>

In this book the execution of an example program is shown in a box which has 
its own caption text. The text inside the box is what appears on the screen of the 
computer when the program is executed. A letter X in the caption text means that 
this describes the execution of the program. The original file name of the program 
is always shown in the caption of a program description.
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2.2  A program that can read from the keyboard and calculate

In the same way as writing text to the screen is called output, the act of reading text from
the keyboard of a computer is called input. We say that a program can input text or numer-
ical data from the keyboard. The screen is an output device, whereas the keyboard is an
input device for a computer program. When speaking about input and output in C++ pro-
gramming, it is customary to speak about input streams and output streams. The name
cout represents the standard output stream which is the screen, and the name cin (pro-
nounced see-in) represents the standard input stream which is the keyboard.

sum.cpp is an example program which can read two integers from the keyboard and
calculate the sum of the integers read. Program sum.cpp is presented as a program
description on the following page. The execution of the program is described below the
source program. Note that because the caption of the source program description has a +
marked, it means there are some parts of the program explained in more detail in other
descriptions.

Integers are one data type in the C++ programming language. Integer variables can
be declared with the reserved keyword int. An integer variable can store an integer value.
Integers are whole numbers ( ... -2, -1, 0, 1, 2, 3, ...) which do not have any decimal points
or decimal fractions. Program sum.cpp first declares the necessary integer variables, then
it asks the user to give values for the integer variables, then it calculates their sum, and
finally the sum of the integers is printed to the screen.

An important element of a computer program is a statement. In C++, statements are
terminated so that a semicolon ; is written at the end of every statement. When the com-
piler of the programming language finds a semicolon in the program text, it knows that
that is the end of a statement. Our first C++ programs consist of  a single entity which is
called the function main(). Inside every function main() there are one or more state-
ments. In program first.cpp there is only one statement inside the function main(), but in
program sum.cpp there are ten statements and each of them has a semicolon ; at the end.

When a computer executes a program, the statements are executed one at a time, in a
sequential order. As a general rule, the statements which are written earlier in a program
are executed before those statements which are written later in the program. For example,
in program sum.cpp, the statement

cout <<  sum_of_two_integers ;

is the last statement to be executed  because it is the last statement in the program.
There are basically two kinds of statements in C++ programs:

• The declaration statements which introduce names and define data. They do not
cause any action to happen in a program. An example of this kind of a statement is

int  first_integer ;

which declares a variable named first_integer. In program sum.cpp, this vari-
able is used to store the first integer that is read from the keyboard.

• Action statements which make a program perform some actions. These statements
can be thought of as commands to the computer, and they usually come after data
declaration statements in a program. In program sum.cpp, an example of this kind
of statement is

sum_of_two_integers  =  first_integer  +  second_integer ;

This statement can be described in a command form such as: "Calculate the sum of
the contents of variables first_integer and second_integer and store the
sum into variable sum_of_two_integers." The variables must be declared in
data declaration statements before these kinds of action statements can be allowed
in a program.
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#include  <iostream.h>

int main()
{
   int  first_integer ;
   int  second_integer ;
   int  sum_of_two_integers ;

   cout <<  "\n Please, type in an integer:      " ;
   cin  >>  first_integer ;

   cout <<  "\n Please, type in another integer: " ;
   cin  >>  second_integer ;

   sum_of_two_integers  =  first_integer  +  second_integer ;

   cout <<  "\n The sum of the given integers is " ;
   cout <<  sum_of_two_integers ;
}

Here, three variables of type int are declared. 
These variables can store integers (whole num-
bers). int is simply an abbreviation of the word 
integer. Note that all program statements in C++ 
are terminated with a semicolon ;

These two statements read numerical values from the 
keyboard. >> is the input operator which reads the input 
stream cin. The numbers which the user of the program 
types in from the keyboard become the values of the vari-
ables first_integer and second_integer.

This is an arithmetic state-
ment which calculates the sum of 
the two integers. After this state-
ment has been executed, the sum 
is stored in the variable named 
sum_of_two_integers.

sum.cpp - 1.+  A program to calculate the sum of two integers.

The most important function of a C++ 
program is called main(). The type of the 
function in this case is int. In most of our 
C++ programs, we will have a function 
named main() whose type is int.

This plus sign means that this program will be further explained on following pages.

sum.cpp - X.  The program is executed here by typing in the integers 17 and 95.

D:\book1cpp>sum

 Please, type in an integer:      17

 Please, type in another integer: 95

 The sum of the given integers is 112
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#include  <iostream.h>

int main()
{
   int  first_integer ;
   int  second_integer ;
   int  sum_of_two_integers ;

   cout <<  "\n Please, type in an integer:      " ;
   cin  >>  first_integer ;

   cout <<  "\n Please, type in another integer: " ;
   cin  >>  second_integer ;

int is a reserved keyword in C++. That means 
that it cannot be used as a name in a C++ program. 
When the C++ compiler reads the word int in a 
program, it knows that an integer variable is being 
declared. 

The term cin represents the keyboard, the standard 
input stream, in a C++ program. With the input operator 
>> it is possible to "move data" from the keyboard to a 
variable. After this statement has been executed, the 
number that was typed in from the keyboard will be the 
value of the variable second_integer.

sum.cpp - 1 - 1:  The first part of the complete program sum.cpp.

These statements print text lines 
to the screen. The marking ’\n’ at 
the beginning of the text causes the 
text to be printed on a new line. 
Therefore ’\n’ is called the newline 
character.

first_integer, second_-
integer, and sum_of_two_integers 
are names of variables in this program. 
The names of variables can be chosen by 
the person who writes a program. In this 
book we write the names so that they 
consist of natural words which are joined 
with underscore characters _ (No space 
characters are allowed in a name.)

   sum_of_two_integers  =  first_integer  +  second_integer ;

   cout <<  "\n The sum of the given integers is " ;
   cout <<  sum_of_two_integers ;
}

Mathematical notations are used 
here. The plus sign + is used as an 
addition operator. The equal sign = 
is an assignment operator.

This is called an assignment statement. The values of 
the variables first_integer and second_integer are 
summed first, and then the calculated sum is assigned as a 
value to the variable sum_of_two_integers. 

sum.cpp - 1 - 2.  The last part of the complete program sum.cpp.
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Usually, there is no single way of writing a computer program. Because program-
ming languages provide a great variety of means to perform various computing activities,
computing problems, like the problem of calculating the sum of two integers, can be
solved with different kinds of programs. Program sum_improved.cpp, on the following
page, is an improved version of program sum.cpp, and it shows another possible way to
write a simple computer program. Although the two programs are doing the same calcula-
tion, program sum_improved.cpp introduces some new features of the C++ programming
language:

• At the beginning of the program, there are some English sentences which explain
briefly what the program does. These sentences are called the comments of the pro-
gram. Comments are actually not part of the program text because they are discard-
ed by the compiler. Comments are intended to be read by humans who want to
study the program. The compiler recognizes comment lines through the double
slash //. Whenever the compiler finds a double slash on some program line, it dis-
cards the double slash and everything that follows until the end of that line.

• Two variables have been given different names in sum_improved.cpp than they
had in sum.cpp. The following modifications have been made to variable names:

first_integer   ->   first_integer_from_keyboard
second_integer  ->   second_integer_from_keyboard

The names of variables can be chosen by the author of a program. Every variable
must have a name that is different from any other variable name in the same pro-
gram. When a variable name is used, it must always be written in exactly the same
way. The names of variables should be chosen so that they describe the purpose of
the variable. C++ allows short and abbreviated variable names like val or i, or
variable names containing numbers like val2, but we will not use them in this
book. Instead, the programs in this book have meaningful variable names which
consist of natural words joined together with underscore characters.

• The output and input operations can be concatenated and that possibility has been
exploited in program sum_improved.cpp. For example,

cout <<  "\n Please, type in two integers separated "
     <<  "with spaces:  " ;

means the same as

cout <<  "\n Please, type in two integers separated " ;
cout <<  "with spaces:  " ;

Exercises with program sum.cpp

Before you can do these exercises, you must read the following sections where you will learn how to edit, compile, 
and execute C++ programs.

Exercise 2-1. Modify program sum.cpp so that when it is given the numbers 17 and 95 it prints the line

17 + 95  =  112

The aim is that the program will print the plus sign + and the equal sign = instead of words.

Exercise 2-2. Modify program sum.cpp so that it calculates the sum of three integers.
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//  sum_improved.cpp (c) 1998 Kari Laitinen

//  This is a simple calculator program that can
//  calculate the sum of the two integers that are
//  typed in from the keyboard.

#include  <iostream.h>

int main()
{
   int  first_integer_from_keyboard ;
   int  second_integer_from_keyboard ;
   int  sum_of_two_integers ;

   cout <<  "\n Please, type in two integers separated "
        <<  "with spaces:  " ;

   cin  >>  first_integer_from_keyboard
        >>  second_integer_from_keyboard ;

   sum_of_two_integers  =  first_integer_from_keyboard  +
                           second_integer_from_keyboard  ;

   cout <<  "\n The sum of "
        <<  first_integer_from_keyboard
        <<  " and "
        <<  second_integer_from_keyboard
        <<  " is "
        <<  sum_of_two_integers
        <<  "\n" ;
}

Sometimes, program state-
ments are so long that they 
need to be written on several 
lines of program text. The 
semicolon ; is the symbol 
which marks the end of each 
statement

sum_improved.cpp - 1.  A slightly improved version of program sum.cpp.

These lines are so-called comment lines which explain in plain English what this par-
ticular program does. Two adjacent slash characters // (a double slash) begin a comment 
line. When a compiler sees a double slash // it ignores those characters and the rest of the 
program line. Note that it is a good programming practice to mention  the program file 
name and the author of the program on some comment lines.

sum_improved.cpp - X.  Program execution with integers 115 and 43.

D:\book1cpp>sum_improved

 Please, type in two integers separated with spaces:  115  43

 The sum of 115 and 43 is 158
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The MS-DOS (console) window in Windows computers

You should read this box if you are not familiar with the use of the MS-DOS window in a computer that runs some 
version of the Microsoft Windows operating system. It is important that you learn to use the MS-DOS window 
because it is used to compile and execute the C++ programs in this book. In addition, you need the MS-DOS win-
dow to perform the installations described in this chapter. In Windows XP, for example, the MS-DOS window can 
be opened by selecting Start > All Programs > Accessories > Command Prompt. The opening of the MS-DOS 
window can be somewhat different in different Windows versions.

Through the MS-DOS window it is possible to carry out many operations by using the commands of the old 
MS-DOS operating system, and thereby control the entire computer. In many cases, you can use either an MS-DOS 
command or the mouse of your computer. For example, you can copy a file with the COPY command, or you can 
use the mouse in the copying operation.

The MS-DOS window can also be called the "command line window" because the MS-DOS commands are 
lines of text written according to a certain syntax. You need to know at least some of the MS-DOS commands in 
order to work with this book. Here are some examples of the MS-DOS commands you may need:

Although the example commands above are written with uppercase letters, you can also write them with low-
ercase letters.

When you use the MS-DOS window in your work, it may be better for your eyes if you adjust the properties 
of the window. The properties can be adjusted, at least in Windows XP, by clicking the symbol in the upper left cor-
ner of the window. I always set the background color to white, text color to black, and the window size to 10 x 18. 
Some large programs in this book require that the screen buffer size is 80 columns x 25 rows (the same as the win-
dow size). When you modify the properties of the MS-DOS window, remember to press the OK button and make 
the modifications permanent.

D: Select drive D.

CD \ Change to the root directory in the current drive.

CD mycpp Change to the directory named mycpp.

CD .. Change to the parent directory of the current directory.

COPY \book1cpp\sum.cpp Copy file sum.cpp from the directory named book1cpp to the current 
directory.

COPY \book1cpp\*.cpp Copy all files which have the name extension .cpp from the directory 
book1cpp to the current directory.

COPY sum.cpp sum_my.cpp Copy a file named sum.cpp to file named sum_my.cpp in the current 
directory.

DIR Display a list of all files and subdirectories in the current directory.

DIR *.cpp Display a list of files whose name terminate with .cpp.

DIR s* Display a list of files whose name begins with letter s.

DIR *sum* Display a list of files that have the word sum in their name.

HELP | MORE Display a list of all MS-DOS commands.

HELP dir Display information of the DIR command.

HELP path Display information of the PATH command.

MD mycpp Create (make) a subdirectory named mycpp in the current directory.

REN test.txt test.old Rename a file named test.txt to test.old in the current directory.
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2.3  Getting a C++ compiler for your computer

As you have now seen a couple of computer programs, you may be eager to experiment
with them on a computer. It is best that you have a personal computer with the Windows
operating system at your disposal when you continue studying with this book, and on your
computer you need to have a C++ compiler to transform C++ source programs into an
executable form.

The C++ programming language is a general-purpose language that can be used to
produce programs for different computers. There thus exist many compilers for the C++
language. Many of the compilers are commercial products, but some compilers are freely
available on the Internet. One free compiler is offered by the Borland Corporation, and I
recommend that you install that compiler into your PC.

To get the free Borland C++ compiler, you need an Internet connection on your PC.
The Internet connection should preferably be a fast one because the file that you have to
download from Borland’s web pages has a size of more than 8 MB (megabytes). Down-
loading a file with this size can take something like half an hour with a modem-based
Internet connection. If you have trouble downloading the compiler from the Borland’s
web pages, you should consult somebody who knows more about downloading larger files
from the Internet.

Before you start downloading the free compiler, you need to have a directory (folder)
to store temporary files on your computer. A temporary directory is also necessary later
when you download other material from the Internet. You can create a temporary directory
named D:\TEMP by writing the following commands in an MS-DOS window

D:
CD \
MD TEMP

When you are ready to get the free Borland C++ compiler, go to the Internet address

http://www.borland.com/bcppbuilder/freecompiler/

with your Internet browser (e.g. Netscape or Internet Explorer). Then you must follow the
instructions that are given on the Borland’s Internet pages. The free compiler is called
C++ Builder Compiler on Borland’s pages. Before you can get the free C++ compiler, you
must become a member in the Borland Developer Network, and you have to fill out a form
where you give your e-mail address and some other information about yourself. The Bor-
land Corporation may advertise its products by sending you e-mails, but in my opinion
that is a low price for an excellent C++ compiler. Logging in to the Borland Developer
Network requires that you invent an exotic login name which does not clash with other
login names.

When you have given the requested information on Borland’s web pages, you can
download the compiler, which is a single file named freecommandLinetools.exe. You
should store this file in the D:\TEMP directory on your computer. The file that contains
the compiler has that name because it is a compiler that can is used on the command line
in an MS-DOS window. The file contains also tools other than just the compiler.

After you have received the file from Borland, you can install the compiler by select-
ing Start > My Computer > D: > TEMP > freecommandLinetools.exe. When you click
the icon that represents the compiler file, the installation process starts. During the instal-
lation process, you may see various information and need to click the Next button to pro-
ceed.

At some phase of the installation process, you are asked for the name of the folder
where the compiler should be installed. (The word "folder" means the same as the word
"directory".) I suggest that you install the compiler in a folder (directory) named

D:\BCC55

All the advice given below is based on the assumption that this is the installation folder. So
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you have to type in the above folder name, and later on you have to give the installation
program the permission to create the new folder. After you have given the installation pro-
gram the necessary information, it starts installing the compiler. Many files are copied to
the new folder, and the installation takes something like a minute.

When the installation program stops, the Borland C++ 5.5 compiler is installed, but
still a few things have to be done before the compiler is fully operational. If you installed
the compiler in the directory D:\BCC55, you should copy two configuration files from
this book’s Internet pages to the subdirectory named D:\BCC55\BIN. To do this, you have
to go to the Internet address

http://www.naturalprogramming.com/borlandcfgfiles/

with your Internet browser. You should use the Netscape browser in this operation. (See
the box on page 24 if you do not have the Netscape browser.) When the above address is
selected, you see two files, bcc32.cfg and ilink32.cfg, with your browser. You can store
these files locally to your computer by first clicking the file name so that the browser
shows the contents of the file, and then doing a File > Save As operation. While doing the
Save As operation, you are asked to give the location where the files should be stored. You
must store the files in the directory (folder) D:\BCC55\BIN. You must store the two files
separately. (Note that the bcc32.cfg and ilink32.cfg files that you can obtain from the
above Internet address work only if your C++ compiler is installed in directory
D:\BCC55. If you installed the compiler in some other directory, you should read the
readme.txt file in that directory in order to create appropriate .cfg files.)

The last thing to do in making your Borland C++ compiler operational is to ensure
that the compiler is found when you invoke the compiler in an MS-DOS window. As the
executable file of your compiler is now in directory (folder) D:\BCC55\BIN, you have to
tell to your computer’s operating system that it should search the compiler in that direc-
tory. This can be achieved, for example, in one of the following ways:

• If you are using the modern Windows XP (Home Edition) operating system, you
should first select Control Panel > Performance and Maintenance > System >
Advanced > Environment Variables, and then you should check if User Variable
named PATH is defined. If the PATH variable is defined, you should modify its val-
ue so that the value of the variable ends like

other directories ; D:\bcc55\bin

If the PATH variable is not defined, you should define it and put D:\BCC55\BIN as
its value. The PATH variable is a list of directory names separated by semicolons.
The operating system uses these directories when it searches executable programs.
After you have done the above modification and saved the new settings, the operat-
ing system knows that it should also search in the directory named
D:\BCC55\BIN.

• If you are using Windows NT or Windows 2000 operating system, the User Vari-
able PATH must be set in the same way as in the case of Windows XP. In Windows
NT, for example, you must select Settings > Control Panel > System > Environ-
ment to set the variables. (Note that if a Windows NT/2000/XP computer is well
protected, you may need to have administrative privileges to modify the variables.)

• If you are using an older Windows operating system like Windows 98, you should
modify a file named autoexec.bat that is in the root of the C: drive. You should
write the line

path = %path%;D:\bcc55\bin

at the end of the autoexec.bat file. You can modify the file by using the standard
Windows text editor called Notepad. You should restart your computer after modi-
fying the autoexec.bat file.
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After you have done one of the above modifications, you can test whether your C++
compiler can be invoked from an MS-DOS window. Therefore, you should first close all
possibly open MS-DOS windows, and then open a new MS-DOS window and write on the
command line

bcc32 test.cpp

If you get a response like

Borland C++ 5.5.1 for Win32 Copyright (c)1993,2000 Borland
Error E2194: Could not find file 'test.cpp'

your compiler works, although it says that it cannot find the .cpp file that was given on the
command line. If the above command resulted in a response where "Borland C++" is not
mentioned, it is likely that something went wrong with the installation of the compiler, or
the PATH is not set correctly.

If your compiler does not work, you can check if the search path is correctly set by
typing

path

in an open MS-DOS window. With this MS-DOS command the current search path is dis-
played. If the text D:\BCC55\BIN is not mentioned among the directories that are on the
search path, the path is not correctly set, and you have to study what went wrong. Check
first that you have not made any small typing mistakes.

If your C++ compiler does not work, although the path is correctly set, it is possible
that something went wrong with the installation of the compiler. In this situation you
should check that there really exists a directory named BCC55 in drive D:, and that direc-
tory has a subdirectory named BIN that contains a file named bcc32.exe. If you cannot
find the directories, you should find out what went wrong with the installation.

Uppercase and lowercase letters in file names

When you work with files and directories in the Windows/MS-DOS operating systems, you should remember that 
the file and directory names can be written both in uppercase and lowercase letters. This means, for example, that 
the directory names BCC55 and bcc55 mean the same, and the file names SUM.CPP and sum.cpp can refer to the 
same file.

We say that the Windows/MS-DOS operating systems are not case sensitive in regard to the file and directory 
names. The UNIX and Linux operating systems are different in this respect. They are case sensitive, which means, 
for example, that a UNIX/Linux directory may contain two different files that have names SUM.CPP and 
sum.cpp.

The difference between uppercase and lowercase letters is important also in programming languages. You 
will learn that the C++ language is case sensitive, which means, for example, that names like SOME_VARIABLE and 
some_variable are considered different names.

Working with other C++ compilers

In this chapter you are given instructions for using the Borland C++ compiler. However, most of the C++ programs 
that are presented in this book can also be compiled with C++ compilers other than the Borland C++ compiler. 
Therefore, you can use other C++ compilers in your studies if you know how to operate them. The Microsoft Cor-
poration provides commercial C++ compilers.  If you are using a Linux or UNIX computer, you probably have a 
C++ compiler named g++ installed on your machine.

If you are studying with this book in an educational institution where C++ compilers are already installed in 
computers that the students may use, you should probably use those compilers or ask your teacher to recommend a 
compiler.
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2.4  Installing the electronic material of this book

In order to study with this book, you need to install some electronic material on your com-
puter. That material includes all the C++ source programs (.cpp files) presented in this
book, and a simulation program that is discussed in Chapter 4.

To obtain the electronic material, go to the web address1

http://www.naturalprogramming.com/

with your Internet browser (e.g. Netscape). At the above address you must first choose a
link for the homepage of this book, then select a link named "Support for readers", and
finally click on "Download C++ source programs and other electronic material". You will
be asked to enter a user name and a password. You must write "think" as the user name and
"natural" as the password to proceed. Remember to write these words in lowercase letters
without the double quotes.

When you have given the correct user name and password, you will see the following
information

ALL_CPP_FILES_ETC.ZIP
book1cpp
book2cpp
book3cpp
bookextracpp
icom

If you are familiar with .zip files, or want to learn how to use .zip files, you should click
the file ALL_CPP_FILES_ETC.ZIP and store it locally in the directory D:\. D:\ is the
root directory of drive D on your computer.

The file ALL_CPP_FILES_ETC.ZIP contains all the .cpp files and other files in a
special compressed format. You should be able to unzip the file on your computer. Unzip-
ping means that .cpp and other files are extracted from the .zip file. The file can be
unzipped in Windows XP by selecting My Computer > Drive D, clicking the icon of the
.zip file and selecting the extraction of all files. When you unzip the file, it automatically
creates a set of directories on your computer, and puts the .cpp and other files into those
directories. I recommend that you extract the files to the directory D:\, the root of drive D.
When the above file is unzipped, it creates the following directories on your computer

book1cpp Contains the .cpp files that are discussed in Part I (Chapter 2) of this
book

book2cpp Contains the .cpp and other files that are presented in Part II (Funda-
mentals of programming) of this book.

book3cpp Contains the .cpp and other files that are presented in Part III (Object-
oriented programming) of this book.

bookextracpp Contains extra .cpp files such as answers to some exercises and special
versions of some of the programs that are discussed in the chapters.

icom Contains the file icom.exe as well as some other files that are discussed
in Chapter 4 of this book.

1. If, for whatever reason, this Internet address does not work, use the Internet search engines to find the electronic 
material of this book. If you search with the full name of this book or with phrases like "Homepage of Kari 
Laitinen", you should be able to find the homepage of this book.
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If you are using the Windows 2000 operating system, you should also be able to
unzip the .zip file easily by clicking the file’s icon. You may try this in other operating sys-
tems as well, but in older Windows operating systems you may need special unzipping
tools.

If you were not able to unzip the .zip file, you can create the above directories on
your own computer by yourself, and download the .cpp files and other files one file at a
time. You can create the directories using the following commands in an MS-DOS win-
dow:

D:
CD \
MD book1cpp
MD book2cpp
MD book3cpp
MD bookextracpp
MD icom

Then you can use your Internet browser to go to the corresponding directories on the Inter-
net. For example, if you click book1cpp on this book’s pages on the Internet, the follow-
ing list of files will be displayed

first.cpp
sum.cpp
sum_improved.cpp

If you click, for example, the file first.cpp, the browser shows the source program on the
screen. When the browser is showing the program, you can click File > Save As, and the
browser lets you save the program locally on your own computer. You should choose the
directory (folder) D:\book1cpp before you save the programs that you found in directory
book1cpp on the Internet. By using the Back button of your browser, and by selecting
other files and other directories, you can get all the .cpp and other files to your computer.
Getting the C++ programs this way is more time consuming than unzipping the .zip file,
but you do not have to download all files at once.

The Netscape browser is more reliable than Microsoft Internet Explorer when .cpp
files are downloaded one file at a time. Therefore, I recommend that you use the Netscape
browser for this task. If you do not have the Netscape browser available, you can down-
load a .cpp file with Internet Explorer if you save the file as a .txt file and later rename it
to a .cpp file.

Netscape vs. Internet Explorer

There exist several, so-called browser programs to access the Internet. Commonly used browsers include Netscape 
and Microsoft Internet Explorer. The Netscape browser is sometimes called Netscape Navigator or Communicator. 
Both of these programs can download files from the Internet. All the downloads described in this chapter can be 
done reliably with Netscape, but using the Internet Explorer to download the .cfg and .cpp files is somewhat com-
plicated. The Internet Explorer works so that normally you use the left mouse button to do selections, but if you 
want to download a file from the Internet, you have to click on the file name with the right mouse button.

When you want to download a .cfg or .cpp file with the Internet Explorer, you first have to see a list of file 
names, and then you have to click on the file name with the right mouse button. When you have used the right 
mouse button, you must select Save Target As ... to store the file locally on your computer. After making this selec-
tion, the Internet Explorer displays a Save As dialog box in which you have to specify into which local directory 
(folder) you want the file to be stored, and how you want the file to be stored. To make the Internet Explorer store  
.cfg or .cpp files correctly, it is best to select All Files to the Save as type: field before you save the file. If you do 
not make this selection, the browser may add the ending .txt to the end of the file name.
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2.5  Compiling with the Borland C++ compiler

I am assuming here that you were able to install the Borland C++ 5.5 compiler and at least
the example programs first.cpp, sum.cpp, and sum_improved.cpp to your computer. If
you had problems with the installation, you have to consult somebody who is more experi-
enced with computers.

Supposing that you installed the program first.cpp in the directory D:\book1cpp,
you can go to see the contents of that directory by first opening an MS-DOS window, and
then typing the commands

D:
cd \book1cpp
dir

After these commands, you should see a list of files that are in the directory D:\book1cpp.
If the file first.cpp is there, you can compile it by typing

bcc32 first.cpp

When the compilation is successful, the compiler prints

Borland C++ 5.5.1 for Win32 Copyright (c)1993,2000 Borland
first.cpp:
Turbo Incremental Link 5.00 Copyright (c)1997,2000 Borland

If the compiler does not produce the above output, you should ensure that you did not
make any typing mistakes, and the compiler installation and the .cfg file installations were
successful. If you type, after a successful compilation, the command

dir first.*

you can see that the compiler produced files named first.obj and first.exe. (The above
command means "list all files whose file name body is ’first’". The asterisk in the com-
mand means "any file name extension".)

The file first.obj is an "object program file" from which the executable file is gener-
ated in the linking process by adding certain standard object programs to it. The file
first.exe is the file that can be executed by your computer. To execute the file, you should
type

first

and the program should produce the output that is shown in the program description of
first.cpp in Section 2.1 of this chapter.

The command with which you invoke the Borland C++ 5.5 compiler is bcc32. The
number 32 in the command name means that it is a 32-bit compiler. 5.5 is the version num-
ber of the compiler. To compile the other .cpp files that have been presented in this chap-
ter, you should type

bcc32 sum.cpp
bcc32 sum_improved.cpp

These commands make the compiler to produce the executable files sum.exe and
sum_improved.exe. The file sum.exe can be executed by typing

sum

In general, if there is a C++ source program file named somefile.cpp, it can be com-
piled by the command

bcc32 somefile.cpp

and a successful compilation produces files named somefile.obj and somefile.exe of
which the .exe file can be executed by writing somefile on the command line.
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2.6  Getting a free editor for your computer

To write and modify computer programs, you need a tool called a program editor on your
computer. There are many tools that can serve as a program editor. For example, in the
Windows operating system there is a standard text editor called Notepad that can be used
as a program editor. You might use Notepad as your program editor for a while, but in the
long run it is better to get an editor that can show line numbers of the program text. Fortu-
nately, there are many working program editors freely available on the Internet. I have
used two free program editors which I can recommend to you.

Jens’ File Editor (JFE)
The first free program editor that you could use is called Jens’ File Editor (JFE). You can
get this editor if you first go to the address

http://www.thefreecountry.com/developercity/editors.shtml

with your Internet browser. In this address you will find a link to a page from where the
Jens’ File Editor can be downloaded. To download the editor, you just click a link at the
beginning of the page, and you will be asked where a file named jfe_e.zip should be
stored on your computer. I recommend that you store the file in D:\TEMP or some other
directory for temporary files.

A .zip file contains other files in a special compressed format, and unzipping means
that the files inside the .zip file are extracted to some directory on your computer. To make
the Jens’ File Editor work, you must unzip the file jfe_e.zip. In the Windows XP operating
system unzipping can be done by just clicking the file’s icon. In the unzipping process it is
important that you extract all files, and I recommend that you extract the files to the direc-
tory D:\BCC55\Bin which is one of your compiler’s directories. Putting the editor files in
that directory has the advantage that the editor is easily found on your computer, provided
that the search path is set as described in Section 2.3.

When you have extracted the editor files to a directory that is on the search path, you
can start the Jens’ File Editor in an MS-DOS window by typing

jfe

Another possibility to start the editor is to create a shortcut to the file jfe.exe in the direc-
tory D:\BCC55\BIN.

The Jens’ File Editor works like Windows programs usually work: the File menu
exists to open and close files, the Edit menu is for Copy and Paste operations, etc. When
you open a .cpp file with the editor, it lets you configure it through the Settings menu. I
usually change the standard configuration so that I set the font to Courier New 10. I rec-
ommend that you ensure that "Soft tabs" is selected in Settings > Tabs, and you put 3 to
the field that specifies how many spaces are inserted to the text when the tabulator key is
pressed. Selecting "Soft tabs" ensures that no tabulator characters enter the program text.
The tabulators can be problematic if you edit your program with another editor, or you
want to print it on paper.

EditPad Lite
Another possible free editor for your use is called EditPad Lite. You might download this,
for example, if you have problems using the Jens’ File Editor. To obtain the EditPad Lite
editor, you have to go to the address

http://www.editpadpro.com/

with your Internet browser. That page is for buying the EditPad Pro editor, but you can
also find a button to download the Lite version of the editor. When you download the edi-
tor, you should get a file named SetUpEditPadLite.exe, and store it in the directory
D:\TEMP of some other directory for temporary files on your computer. Then you should
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execute the downloaded .exe file to perform the actual installation. The installation pro-
gram automatically creates a shortcut through which you can start the editor program.

The EditPad Lite editor works in much the same way as the Jens’ File Editor. You
may not use EditPad Lite for any commercial purposes. Also the EditPad editor should be
configured so that when the tabulator (Tab) key is pressed no tabulator characters enter the
text. This can be achieved by selecting Options > Preferences > Editor, ticking "Pressing
Tab inserts spaces instead of tab characters", and putting 3 to the numerical fields.

2.7  Modifying and recompiling programs

When you start doing programming exercises, it is best to create a special directory
(folder) for those .cpp files that you write by yourself. Such a directory can have, for
example, the name D:\mycpp. To create this directory, you should type the following
commands in an MS-DOS console window

D:
CD \
MD mycpp

Let’s now suppose that you want to start modifying the program first.cpp that was
discussed in Section 2.1. When you start modifying an example program that is presented
in this book, it is best to make a copy of the program, and give a new file name for the new
.cpp file. Provided that you have installed the electronic material as described in Section
2.4, you can copy the program first.cpp with the following commands

D:
CD \mycpp
COPY \book1cpp\first.cpp myfirst.cpp

(If drive D is already selected, the first command above is not necessary.) The above
COPY command gives the name myfirst.cpp to the copied file. After the above com-
mands are given, you can compile and execute the program myfirst.cpp by typing the fol-
lowing commands

bcc32 myfirst.cpp
myfirst

Program myfirst.cpp should work exactly in the same way as program first.cpp. After
you are sure that program myfirst.cpp can be compiled and it works properly, you can
start modifying it.

In order to modify the program, you must read the file myfirst.cpp into a program
editor (e.g. JFE, EditPad Lite, or Notepad). To do this, you should first start the program
editor, and then select File > Open. While opening the file, you must first specify the
directory D:\mycpp, and then select file myfirst.cpp. The file is opened successfully
when the editor displays the program text. In the file opening operation the text from the
file myfirst.cpp is copied inside the program editor.

When the program myfirst.cpp is being shown in the editor window, you can modify
it by using the keyboard and the mouse of your computer. To make a test modification, you
could add the line

cout  <<  "\n This is a test line. " ;

before the closing brace } in the program. After you have made this modification, you
should save the file by selecting File > Save. Another possibility for saving a file in a pro-
gram editor is to use the Save button. Both JFE and EditPad Lite editors have a Save but-
ton. The saving operation stores the modified program into the file myfirst.cpp on the
hard disk of the computer. Saving a file after modification is important because the C++
compiler will read the file that is on the computer’s hard disk. The compiler cannot read
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the file that is inside the program editor.
After the file myfirst.cpp has been modified and saved, you must click the MS-DOS

window with the mouse. Then you can recompile and re-execute the modified program
with the commands

bcc32 myfirst.cpp
myfirst

If the compilation succeeds, you should see the effect of the modification on the screen.
Typically, when you work with a program, you have two windows, an editor window

and an MS-DOS window, open on the screen. In the editor window you modify the pro-
gram and in the MS-DOS window you compile and execute the program. You can move
from one window to the other window by clicking on the window you want to use. When-
ever you start compiling a program in the MS-DOS window, you must first save the pro-
gram in the editor window.

When doing a programming exercise or writing some other program, it is usual that
you have to modify, compile, and execute your program many times before the program
works in the way you want. In such a program development process, you need to repeat
the compilation and execution commands over and over. Fortunately, the MS-DOS win-
dow is designed so that you can recompile and re-execute your programs easily, without
having to retype the commands. If you have once typed the compilation execution com-
mands, like those above, you can find the commands again by using the Arrow Up key on
the keyboard of your computer. You can scroll through the old commands with the Arrow
Up and Arrow Down keys. After you find an old command which you want to re-execute,
you just press the Enter key. This way, once-written compilation and execution commands
can be executed repeatedly, and recompilation and re-execution of your program is rather
easy. To recompile after the modification of a program, you just need to click the MS-DOS
window and use the Arrow Up and Arrow Down keys to find the previous compilation
command.


